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RX110, RX111, RX113, RX130, RX231, RX23T Group 

RX Driver Package Ver.1.02  

Introduction  

This document is the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package User’s Manual, 

version 1.02. 

This User’s Manual describes basic structures, features and usage of RX Driver Package applications, and about the 

sample application program using the FIT modules included in this package. 

 

Target Device  

RX110 Group (Renesas Starter Kit RX110) 

RX111 Group (Renesas Starter Kit RX111) 

RX113 Group (Renesas Starter Kit RX113) 

RX130 Group (Renesas Starter Kit RX130) 

RX231 Group (Renesas Starter Kit RX231) 

RX23T Group (Renesas Starter Kit RX23T) 

 

When using this application note with your product, careful evaluation is recommended. 

And when using this application note with other Renesas MCUs, careful evaluation is recommended after making 

modifications to comply with the alternate MCU. 

 

Related Documents 

 RX Family  Board Support Package Module Using Firmware Integration Technology (R01AN1685EU) 

 Firmware Integration Technology User’s Manual (R01AN1833EU) 

 RX Family  Adding Firmware Integration Technology Modules to Projects (R01AN1723EU) 

 RX Family  Adding Firmware Integration Technology Modules to CS+ Projects (R01AN1826EJ) 

 The User’s Manual provided with the RX Driver Package Application. 
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1. Overview 

1.1 Applicability 

This User’s Manual applies to the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package, version 

1.02. 

 

1.2 Operating Environment 

This package runs under the operating environment described below. 

 

Table 1-1   Operating Environment (RX110) 

Microcontroller RX110 Group 

Evaluation board Renesas Starter Kit RX110 

Integrated development 

environment (IDE) 

e2 studio, V4.0.2 or later 

 

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later 

Emulator E1, E20 

 

Table 1-2   Operating Environment (RX111) 

Microcontroller RX111 Group 

Evaluation board Renesas Starter Kit RX111 

Integrated development 

environment (IDE) 

e2 studio, V4.0.2 or later 

 

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later 

Emulator E1, E20 

 

Table 1-3   Operating Environment (RX113) 

Microcontroller RX113 Group 

Evaluation board Renesas Starter Kit RX113 

Integrated development 

environment (IDE) 

e2 studio, V4.0.2 or later 

 

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later 

Emulator E1, E20 

 

Table 1-4   Operating Environment (RX130) 

Microcontroller RX130 Group 

Evaluation board Renesas Starter Kit RX130 

Integrated development 

environment (IDE) 

e2 studio, V4.0.2 or later 

 

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later 

Emulator E1, E20 
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Table 1-5   Operating Environment (RX231) 

Microcontroller RX231 Group 

Evaluation board Renesas Starter Kit RX231 

Integrated development 

environment (IDE) 

e2 studio, V4.0.2 or later 

 

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later 

Emulator E1, E20 

 

Table 1-6   Operating Environment (RX23T) 

Microcontroller RX231 Group 

Evaluation board Renesas Starter Kit RX23T 

Integrated development 

environment (IDE) 

e2 studio, V4.0.2 or later 

 

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later 

Emulator E1, E20 
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2. About RX Driver Package 

The RX Driver Package is a software platform (framework) that combines the following modules to be required for 

development in a single package. Since the package contains multiple modules, you can start developing immediately 

without having to obtain each module separately. 

 Board Support Package (BSP) module 

 FIT peripheral function modules (free version)  

 FIT middleware modules (free version) 

 FIT interface modules  

 

You can develop the user application layer with ease by using the Sample Application Program (RX Driver Package 

Application) which utilizes the RX Driver Package. 

2.1 System Structure 

The figure below shows the system structure of the RX Driver Package. 

 

 

Figure 2-1   System Structure 
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2.2 RX Driver Package Features 

The RX Driver Package has the following features. 

 

(a) Select necessary modules and start developing immediately the application program 

 You can easily build a system simply by selecting the modules you need from the package. After that, all you have to 

do is develop the application program. 

 

 

Figure 2-2   An example of system build 

 

(b) Free to use 

All the modules included in the RX Driver Package can be used free of charge. Free versions of middleware modules 

such as TCP/IP and file system are included. 

 

(c) Can upgrade to paid versions of modules 

The free versions of modules in the RX Driver Package can be replaced with commercial (paid) versions. By using a 

commercial (paid) version, all the functionality of the module will be available, as well as support about a commercial 

version. 

 

(d) Check operation including user application 

The RX Driver Package Application is provided as a sample user application that uses the RX Driver Package. The RX 

Driver Package Application consists of programs for operating each module in the RX Driver Package, and the project 

files for building the programs. It enables you to start checking the operation of your user application immediately. 
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3. Structure of the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver 
Package 

3.1 Folder Structure 

The folder structure used in this package is shown below. 

When the ZIP file for this package is downloaded from the Renesas web site and decompressed, a folder of the same 

name will be present and it will contain a FITModules folder, a reference_documents folder, and this document. 

The FITModules folder contains the FIT modules for the modules shown in Table 3-1(as ZIP files and XML files). 

The reference_documents folder contains the documentation for using this package in various development  

 

 

Figure 3-1   Folder Structure of the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver 

Package 
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3.2 Module Structure 

The figure below shows the types and structure of the FIT modules included in this package. 

 

 

Figure 3-2   RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package FIT Module 

Structure 

 



RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package Ver.1.02 

R01AN3159EJ0102  Rev.1.02  Page 9 of 28 

Feb 29, 2016  

3.3 FIT Modules 

The table below lists the FIT modules included in this package. 

 

Table 3-1   RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package FIT Modules 

Type Module  FIT Module 

Name 

R 

X 

1 

1 

0 

R 

X 

1 

1 

1 

R 

X 

1 

1 

3 

R 

X 

1 

3 

0 

R 

X 

2 

3 

1 

R 

X 

2 

3 

T 

 Rev 

Board Support 

Package 

Board Support Package (BSP) r_bsp ✓ ✓ ✓ ✓ ✓ ✓  3.20 

Device Driver Clock Generation Circuit (CGC) r_cgc_rx100 ✓ ✓ ✓ - - -  1.31 

Device Driver Low Power Consumption (LPC)  r_lpc_rx100 ✓ ✓ ✓ - - -  1.30 

Device Driver Battery Backup (VBATT) r_vbatt_rx - - - - ✓ -  1.01 

Device Driver Interrupt Controller (IRQ)  r_irq_rx ✓ ✓ ✓ ✓ ✓ ✓  1.90 

Device Driver Data Transfer Controller (DTC) r_dtc_rx ✓ ✓ ✓ ✓ ✓ ✓  2.04 

Device Driver DMA Controller (DMAC) r_dmaca_rx - - - - ✓ -  1.03 

Device Driver I/O Ports (GPIO) r_gpio_rx ✓ ✓ ✓ ✓ ✓ ✓  1.80 

Device Driver Multi-Function Pin Controller (MPC)  r_mpc_rx ✓ ✓ ✓ ✓ ✓ ✓  1.90 

Device Driver Compare Match Timer (CMT) r_cmt_rx ✓ ✓ ✓ - ✓ -  2.60 

Device Driver Real-Time Clock (RTC) r_rtc_rx ✓ ✓ ✓ - ✓ -  2.40 

Device Driver Independent Watchdog Timer (IWDT) r_iwdt_rx ✓ ✓ ✓ ✓ ✓ -  1.50 

Device Driver Serial Communications Interface (SCI: 

Asynchronous/Clock Synchronous) 

r_sci_rx ✓ ✓ ✓ - ✓ ✓  1.70 

Device Driver Serial Communications Interface (SCI: Simple 

I2C Bus) 

r_sci_iic_rx ✓ ✓ ✓ ✓ ✓ ✓  1.80 

Device Driver I2C Bus Interface (RIIC) r_riic_rx ✓ ✓ ✓ ✓ ✓ ✓  1.80 

Device Driver Serial Peripheral Interface r_rspi_rx ✓ ✓ ✓ - ✓ -  1.40 

Device Driver Serial Peripheral Interface (RSPI: Device Driver 

for Serial Memory Control) 

r_rspi_smstr_rx ✓ ✓ ✓ ✓ ✓ ✓  1.10 

Device Driver USB Basic Firmware r_usb_basic_mini - ✓ ✓ - ✓ -  1.02 

Device Driver USB Host Mass Storage Class r_usb_hmsc_mini - ✓ ✓ - ✓ -  1.02 

Device Driver USB Host Communication Device Class r_usb_hcdc_mini - ✓ ✓ - ✓ -  1.02 

Device Driver USB Host Human Interface Device Class r_usb_hhid_mini - ✓ ✓ - ✓ -  1.02 

Device Driver USB Peripheral Mass Storage Class r_usb_pmsc_mini - ✓ ✓ - ✓ -  1.02 

Device Driver USB Peripheral Communications Device Class r_usb_pcdc_mini - ✓ ✓ - ✓ -  1.02 

Device Driver USB Peripheral Human Interface Device Class r_usb_phid_mini - ✓ ✓ - ✓ -  1.02 

Device Driver IrDA Interface (IrDA) r_irda_sci_rx - - ✓ - - -  1.01 

Device Driver CAN Module (RSCAN) r_rscan_rx - - - - ✓ -  1.00 

Device Driver 12-Bit A/D Converter (S12AD) r_s12ad_rx ✓ ✓ ✓ - ✓ -  2.10 

Device Driver D/A Converter (DAC) r_dac_rx  ✓ ✓ ✓ ✓ ✓  2.70 

Device Driver Flash Memory (Flash API) r_flash_rx ✓ ✓ ✓ ✓ ✓ ✓  1.50 

Device Driver Serial Sound Interface (SSI) r_ssi_api_rx - - ✓ - ✓ -  1.20 

Device Driver LCD Controller/Driver (LCDC) r_lcdc_rx - - ✓ - - -  1.00 

Device Driver Unique ID Read r_uid_rx ✓ ✓ ✓ - - -  1.00 

Device Driver Byte Queue Buffer (Data Management) r_byteq ✓ ✓ ✓ ✓ ✓ ✓  1.60 

Device Driver Long Queue Buffer (Data Management) r_longq ✓ ✓ ✓ ✓ ✓ ✓  1.60 

 

 

http://www.renesas.com/request?SCREEN_ID=ViewDocumentSearch&EXECUTE_ACTION=search&DOCUMENT_NO=r01an1727


RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package Ver.1.02 

R01AN3159EJ0102  Rev.1.02  Page 10 of 28 

Feb 29, 2016  

Type Module  FIT Module 

Name 

R 

X 

1 

1 

0 

R 

X 

1 

1 

1 

R 

X 

1 

1 

3 

R 

X 

1 

3 

0 

R 

X 

2 

3 

1 

R 

X 

2 

3 

T 

 Rev 

Middleware TCP/IP M3S-T4-Tiny for Embedding r_t4_rx ✓ ✓ ✓ ✓ ✓ ✓  2.05 

Interface Embedded TCP/IP M3S-T4-Tiny Socket API 

Module 

r_socket_rx ✓ ✓ ✓ ✓ ✓ ✓  1.30 

Middleware DHCP client using the embedded TCP/IP M3S-

T4-Tiny Module 

r_t4_dhcp_client_r

x 

✓ ✓ - - - -  1.03 

Middleware DNS client using the embedded TCP/IP M3S-

T4-Tiny Module 

r_t4_dns_client_rx ✓ ✓ - - - -  1.02 

Middleware FTP server using the embedded TCP/IP M3S-

T4-Tiny Module 

r_t4_ftp_server_rx ✓ ✓ - - - -  1.03 

Middleware Web server using the embedded TCP/IP M3S-

T4-Tiny Module 

r_t4_http_server_r

x 

✓ ✓ - - - -  1.04 

Middleware Sound playback system and compression 

system (original ADPCM codec) 

r_s2_rx - ✓ ✓ - ✓ -  3.03 

Middleware M3S-TFAT-Tiny (FAT file system) r_tfat_rx - ✓ ✓ - ✓ -  3.02 

Interface M3S-TFAT-Tiny Memory Driver Interface 

Module 

r_tfat_driver_rx - ✓ ✓ - ✓ -  1.02 

Middleware Simple I2C Module for EEPROM Access r_eeprom_sci_iic_

rx 

✓ ✓ ✓ - - -  1.30 

Middleware I2C Bus Interface (RIIC) Module for EEPROM 

Access 

r_eeprom_riic_rx ✓ ✓ ✓ - - -  1.40 

Middleware SPI Serial EEPROM Module r_eeprom_spi ✓ ✓ ✓ ✓ ✓ ✓ ✓ 2.33 

Middleware SPI Serial Flash memory Module r_flash_spi ✓ ✓ ✓ ✓ ✓ ✓ ✓ 2.33 

Note: This package includes the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the 

commercial version, please go to the below URL. 

http://www.renesas.com/mw/t4 

 

 

 

http://www.renesas.com/mw/t4
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4. Usage Procedures 

The RX Driver Package allows programs to be easily constructed by using the FIT plugin included in e2 studio. The 

remainder of this section presents a simple usage example using e2 studio. To use CS+, see the document “RX Family 

Adding Firmware Integration Technology Modules to CS+ Projects (R01AN1826EJ)” included in this package. 

 

4.1 Environment Used 

The RX231 is used as the target microcontroller and the Renesas Starter Kit RX231 is used as the target board. If a 

different environment is used, replace the specifics used in the example with the ones for that environment as you read. 

 

4.2 Install RX Driver Package in e2 studio 

Install the FIT modules in the RX Driver Package into e2 studio. 

 

1. Decompress the downloaded file an_r01an2670ej0101_rx.zip into an arbitrary directory. 
 
2.  Open the folder that was decompressed and open the FITModules folder in that folder. 
 
3. Select all the files in the FITModules folder and click Copy in the Edit menu. 

 
 

Select all files and click 

Copy in the Edit menu. 



RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package Ver.1.02 

R01AN3159EJ0102  Rev.1.02  Page 12 of 28 

Feb 29, 2016  

4.  Open the e2 studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in 

that folder. 
 
5.  Click Paste on the Edit menu. 

The e2 studio FITModules folder will be copied to the FIT modules. 

 
 
 

4.3 Application Creation 

In this section, create a simple application that drives an LED. 

 

4.3.1 Create a Workspace and a Project 

First, create a new workspace and a new project. 

1.  Start e2 studio. 
 
2.  Enter an arbitrary workspace folder in the displayed dialog box and click OK. 

 
 

Open the FITModules 

folder and click Paste  

on the Edit menu.  

The folder will be copied. 

Enter a workspace 

folder. 

Click OK. 
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3.  When the following window is displayed, click Workbench. 

 
 
 
4.  When the workbench has started, select New from the File menu and click C Project. 

 
 

Click Workbench. 

Click here. 
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5.  Enter the project name. For the project type, click Sample Project under Executable (Renesas). For the tool chain, 

click Renesas RXC Toolchain. After making these settings, click Next. 

 
 
6.  Select the target. Click the “...” button under Target Selection and select R5F52318AxFP. After making these 

settings, click Next. 

 
 

Click here. 
 

Enter the 

project name. 

Click here. 
 

Click here and 

select 

R5F52318AxFP. 
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7.  Set the check box of “Use FIT module” and click Next here. 

 
 
8.  Simply click Next here. 

 
 

Click here. 
 

Click here. 
 

Set the check box 
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9.  Simply click Next here. 

 
 
10. Simply click Finish here. 

 
 

Click here. 
 

Click here. 
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11.Click OK. The project will be generated. 

 
 
 

Click here. 
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4.3.2 Install the FIT Modules with the FIT Plugin. 

Install the required modules with the FIT plugin into the created project. 

Here, install the BSP module (r_bsp) and the compare match timer driver (r_cmt_rx). 

 

1.  In the Renesas Views menu, select e2 solution toolkit and click FIT Configurator. 

 
 
2.  In the FIT Configurator tab, 

Select the created project with Project to Add FIT Module to. 

Next, select RX231 under Group and select RSKRX231 from Target Board. 

Next, click r_cmt_rx in the module list and click Add Module >>. 

 
 

Click here. 
 

 

 

 

 

 

 

 

 

Select the project. 
 

Select this item. 
 

Click here. 
 

 

 

 

 

 

 

 

Select the target board. 
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3.  In the Console tab, 

 In the current example, the r_bsp having a dependency with r_cmt_rx is also added at a time. * 

 Click FIT Configurator again. 

  

 *: The r_bsp version defined in r_cmt_rx is 2.90 version or later.  As r_bsp version packaged in the RDP is 3.20, 

the Warning (W0000001) occurs on the console screen. However, as the Warning has no impact on adding the 

module, it can be ignored.  

 

 
 

4. Check r_bsp and r_cmt_rx are added in Selected Modules. The mark  on r_cmt_rx indicates occurrence of the 

Warning explained in the above 3. 

 Then, click Generate Code.  

 

Click here. 
 

 

 

 

 

 

 

 

This is no problem to ignore this warning. 

Check here. 
 

 

 

 

 

 

 

 

Click here. 
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5. Click OK with changing anything. 

 
 

Click here. 
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4.3.3 Create an LED Driving Program 

Create a program that toggles the LED0 on/off state every 0.5 seconds using the compare match timer. 

Open the file src/(the project name).c and modify it as shown below. 

src/(the project name).c 

#include "platform.h" 

#include "r_cmt_rx_if.h" 

 

/* LED Currently status */ 

uint32_t ledstatus = LED_OFF; 

 

void call_back(void *pdata) 

{ 

 if (ledstatus == LED_OFF) 

 { 

    /* Turn ON the LED0 If the status is LED_OFF */ 

  LED0 = LED_ON; 

  ledstatus = LED_ON; 

 } 

 else 

 { 

    /* Turn OFF the LED0 If the status is LED_ON */ 

  LED0 = LED_OFF; 

  ledstatus = LED_OFF; 

 } 

} 

 

void main(void) 

{ 

 uint32_t cmt_ch; 

 

 /* LED0 off */ 

 LED0 =LED_OFF; 

 /* Create of 0.5 second(2Hz) cyclic timer. */ 

 R_CMT_CreatePeriodic(2, &call_back, &cmt_ch); 

 

 while(1); 

} 
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4.3.4 Build and Try Running the Program 

Build the program just created and verify that it runs. 

 

1.  Click Build Project on the Project menu. 

  
 
2.  When the build completes, the following will be displayed in Console view. 

  
 
3.  Click Debug Build on the Run menu. 

 
 

Click here. 

Click here. 
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4.  Click  under the Renesas GDB Hardware Debugging and click led_sample HardwareDebug. Click the 

Debugger tab and click Connection Setting. 

Modify EXTAL Frequency to be 8.0000 and change Provide Power from Emulator to No *. 

When these changes have been made, click Debug. 

 

Note : This is setting when using an external power supply. When supplying power from the emulator, select Yes. 

 

 
 

Click here. 

Click here. 

Modify to be 

8.0000. 

Modify to be No. 



RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package Ver.1.02 

R01AN3159EJ0102  Rev.1.02  Page 24 of 28 

Feb 29, 2016  

5. When the following message is displayed, click Yes. 

 
 
6. When the load module download completes, a Debug perspective opens. 

 
 
7.  Click Restart on the toolbar. The program will be executed and a break will occur at the start of the main function. 

 
 
8. After the break at the start of the main function, click Restart on the tool bar again. 

The project will be run and the program will iterate toggling LED0 with a period of 0.5 seconds. 

 

Click here. 

Click here. 
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4.3.5 For location of the API information of each FIT module 

For the API information of FIT module embedded in the project, refer to the doc folder of each FIT module folder. 
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5. RX Driver Package Application 

5.1 RX Driver Package Application Structure 

The RX Driver Package Application is a sample application program provided so that users can use the RX Driver 

Package easily. The RX Driver Package Application consists of an application program that operates using device 

drivers and middleware included in the RX Driver Package and a project file for building that application. This allows 

users to start evaluation quickly. 

 

Figure 5-1   RX Driver Package Application Structure 

 

Renesas plans to release a variety of types of this RX Driver Package Application in the future, such as system 

programs that operate using a combination of multiple drivers and middleware and evaluation programs for independent 

modules from the RX Driver Package. 

For information of the latest RX Driver Package Application, refer to the “Products Supporting RX Driver Package 

Application” shown in the following URL. 

http://www.renesas.com/products/mpumcu/rx/child/fit.jsp 

 

 

Figure 5-2   Types of RX Driver Package Application 

 

 

http://www.renesas.com/products/mpumcu/rx/child/fit.jsp
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6. Supplement 

6.1 Commercial Version of Middleware and Drivers Supporting FIT 

A list of the commercial version (paid) Middleware and Drivers for RX family is shown below. 

For the information of the latest commercial version (paid) Middleware and Drivers, refer to the page of the 

Middleware and Drivers shown in the following URL. 

 

Page of Middleware and Drivers: http://www.renesas.com/mw/ 

 

Table 6-1   list of the commercial version (paid) Middleware and Drivers for RX family 

Commercial Version URL FIT 

Compliant 

TCP/IP for Embedding 

M3S-T4-Tiny 

http://www.renesas.com/mw/t4 Available 

 

http://www.renesas.com/mw/
http://www.renesas.com/mw/t4
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Website and Support  

Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
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Revision History  

Rev. Date 

Description 

Page Summary 

1.00 Sep 1, 2014 - First edition issued 

1.01 Oct 31, 2015 - Updated existing modules to latest modules. 

Added RX110, RX111 and RX231.  

Updated e2studio version and changed set-up procedure. 

Changed document number from R01AN2466EJ0100 to 

R01AN2670EJ0101. 

1.02 Feb 29, 2016  Updated existing modules to latest modules. 

Added RX130 and RX23T.  

Changed document number from R01AN2670EJ0101 to 

R01AN3159EJ0102. 

 



 

 

General Precautions in the Handling of MPU/MCU Products 

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the 

products covered by this document, refer to the relevant sections of the document as well as any technical updates that 

have been issued for the products. 

1. Handling of Unused Pins 

Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual. 

 The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin 

in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-

through current flows internally, and malfunctions occur due to the false recognition of the pin state as an 

input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in 

the manual. 

2. Processing at Power-on 

The state of the product is undefined at the moment when power is supplied. 

 The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are 

undefined at the moment when power is supplied. 

In a finished product where the reset signal is applied to the external reset pin, the states of pins 

are not guaranteed from the moment when power is supplied until the reset process is completed. 

In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function 

are not guaranteed from the moment when power is supplied until the power reaches the level at 

which resetting has been specified. 

3. Prohibition of Access to Reserved Addresses 

Access to reserved addresses is prohibited. 

 The reserved addresses are provided for the possible future expansion of functions. Do not access these 

addresses; the correct operation of LSI is not guaranteed if they are accessed. 

4. Clock Signals 

After applying a reset, only release the reset line after the operating clock signal has become stable. 

When switching the clock signal during program execution, wait until the target clock signal has 

stabilized. 

 When the clock signal is generated with an external resonator (or from an external oscillator) during a reset, 

ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when 

switching to a clock signal produced with an external resonator (or by an external oscillator) while program 

execution is in progress, wait until the target clock signal is stable. 

5. Differences between Products 

Before changing from one product to another, i.e. to a product with a different type number, confirm 

that the change will not lead to problems. 

 The characteristics of an MPU or MCU in the same group but having a different part number may differ in 

terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of 

electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of 

radiated noise. When changing to a product with a different part number, implement a system-evaluation test 

for the given product. 



 

 

Notice
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples.  You are fully responsible for

the incorporation of these circuits, software, and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use

of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free.  Renesas Electronics

assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or

technical information described in this document.  No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or

others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  Renesas Electronics assumes no responsibility for any losses incurred by you or

third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality".  The recommended applications for each Renesas Electronics product depends on

the product's quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical

implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.).  You must check the quality grade of each Renesas Electronics product before using it

in a particular application.  You may not use any Renesas Electronics product for any application for which it is not intended.  Renesas Electronics shall not be in any way liable for any damages or losses

incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

range, movement power voltage range, heat radiation characteristics, installation and other product characteristics.  Renesas Electronics shall have no liability for malfunctions or damages arising out of the

use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and

malfunctions under certain use conditions.  Further, Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to guard them against the

possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because the evaluation of microcomputer software alone is very difficult,

please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product.  Please use Renesas Electronics

products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.  Renesas Electronics assumes

no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or

regulations.  You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the

development of weapons of mass destruction.  When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and

regulations and follow the procedures required by such laws and regulations.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the

contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics

products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

http://www.renesas.com

Refer to "http://www.renesas.com/" for the latest and detailed information.
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